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Trademarks 

Microsoft is a U.S. registered trademark of Microsoft 
Corporation. 
Windows, Windows XP, Windows Vista and Windows 7 are 
trademarks of Microsoft Corporation. 
IBM, IBM PC are registered trademarks of International Business 
Machines Corp. 
ENERGY STAR® is a U.S. registered mark. 
Other brands and product names herein are trademarks or 
registered trademarks of their respective holders. 

Copyright 

All rights reserved. No part of this publication may be 
reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language or computer language, 
in any form or by any means, electronic, mechanical, magnetic, 
optical, chemical, manual, or otherwise, without the prior 
written permission of Avision Inc. 
 
Material scanned by this product may be protected by 
governmental laws and other regulations, such as copyright 
laws, the customer is solely responsible for complying with all 
such laws and regulations. 

 

Warranty 

The information contained in this document is subject to 
change without notice. 
 
Avision makes no warranty of any kind with regard to this 
material, including, but not limited to, the implied warranties 
of fitness for a particular purpose. 
 
Avision shall not be liable for errors contained herein or for 
incidental or consequential damages in connection with the 
furnishing, performance, or use of this material.  
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FCC Radio Frequency Interference Statement  

This product has been tested and found to comply with the 
limits for a class B digital device, pursuant to Part 15 of 
the FCC rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that may 
cause undesired operation.   The FCC Class B limits are 
designed to provide reasonable protection against harmful 
interference in a residential installation. This equipment 
generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or 
television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following 
measures: 

 Reorient or relocate the receiving antenna. 
 Increase the separation between the equipment and 

receiver. 
 Connect the equipment into an outlet on a circuit 

different from that to which the receiver is connected. 
 Consult your point of purchase or service representative 

for additional suggestions. 
 

 

As an ENERGY STAR® Partner, Avision Inc. has 
determined that this product meets the ENERGY 
STAR guidelines for energy efficiency. 
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European Union Regulatory Notice 
 
Products bearing the CE marking comply with the following EU 
Directives: 
 
• Low Voltage Directive 2006/95/EC 
• EMC Directive 2004/108/EC 
 
CE compliance of this product is valid if powered with the 
correct CE-marked AC adapter provided by Avision. 
 
This product satisfies the Class B limits of EN55022, EN55024 
and safety requirements of EN 60950. 
 
*This machine is certified as Class 1 LED product. This means 
that this machine does not produce hazardous laser radiation. 
 

Disposal of Waste Equipment  

 

This symbol on the product or on its packaging indicates that 
the product can not be disposed of with your other household 
waste.  Instead it should be sent to appropriate facilities for 
recovery and recycling in an effort to protect human health and 
the environment.  Fore more information about where you can 
drop off your waste equipment for recycling, please contact 
your local city office, your household waste disposal service or 
the shop where you purchased the product.   
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System Requirements 

 
 IBM compatible PC 586, Pentium or higher 

 Microsoft Windows 2000, Windows XP, Windows 
Vista/Windows 7 

 USB port 2.0 (compatible with USB 1.1) 

 At least 100 MB of free hard disk space (500 MB is 
recommended) 

 At least 128 MB of system memory (512 MB of RAM is 
recommended)  

At least 1 GB of RAM for Windows Vista 

 A CD-ROM drive 
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1.  Introduction 
 
 
 
 

Congratulations on your purchase of the color image 
scanner.  With this scanner, you can scan documents in a 
rated speed to increase your productivity.  

Before you install and operate the new scanner, please take 
a few minutes to read through this manual.  It provides 
proper instructions for you to unpack, install, operate and 
maintain the scanner. 

The following figure indicates the package contents.  Please 
check all the items against your checklist.  If you do not 
receive all the items, please contact your authorized local 
dealer immediately. 

                 

2 1 

 

           

3 4 

1. Scanner main unit 
2. Power adapter 
3. Power cord 
4. USB cable 
5. User’s manual/CD 
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Note:  
1. Only use the AC adapter (HEG42-240200-7L made by 

HiTron or DA-48M24 made by APD) included in the 
machine.  Using other AC adapters may damage the 
machine and void the warranty. 

2. Please unpack the packing carefully, and check the contents 
against the checklist.  If any items are missing or damaged, 
please contact your dealer immediately. 
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2.   Scanner Installation 
 

 

Precautions 

 
 Keep the scanner out of direct sunlight.  Direct 

exposure to the sun or excessive heat may cause 
damage to the unit. 

 Do not install the scanner in a humid or dusty place. 

 Be sure to use the proper AC power source. 

 Place the scanner securely on an even, flat surface.  
Tilted or uneven surfaces may cause mechanical or 
paper-feeding problems. 

 Retain the scanner box and packing materials for 
shipping purposes. 
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2.1 Installing the Scanner Driver and Cables 

NOTE:  
1). The Windows system CD may be required when installing 

on some PC’s. 
2). To ensure your computer can identify the USB scanner, 

please install scanner driver first before connecting the 
scanner to your computer. 

3). The scanner driver contains both TWAIN driver and WIA 
driver.  If you are running Windows Me, Windows XP, or 
Windows Vista, after the installation of scanner driver is 
completed, this scanner allows you to scan via a TWAIN 
user interface or a WIA (Windows Image Acquisition) 
interface.  Start your TWAIN-compatible image editing 
software application to select a TWAIN or WIA user 
interface.  Or you might launch Microsoft’s Scanner and 
Camera Wizard to scan via a WIA user interface. 

 

2.1.1 Connecting to Power 

Plug the small end of the power adaptor into the power jack of 
your scanner.  Insert the other end to an appropriate power 
outlet. 
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2.1.2 Turning on the Scanner 
 

Press the Power Switch button on the front panel, the Power 
LED will be lit.  To turn off the scanner, press the Power 
Switch button for about 3 seconds, the Power LED will be off. 

 
 

2.1.3 Installing the Scanner Driver 
 
1. Place the supplied CD-ROM onto your CD-ROM drive. 

2. The software installation graphic appears.  If not, run 
“setup.exe”. 
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Contents on the installation graphic: 

• Install Button Manager:  To use the buttons on 
the scanner, you need to install Button Manager.  To 
ensure Button Manager works properly, please FIRST 
install Button Manager before installing the scanner 
driver. 

• Install Scanner Driver:  To communicate with your 
scanner, you need to install the scanner driver.  After 
installing the Button Manager software, click Install 
Scanner Driver to install the scanner driver on your 
computer. 

• Install Adobe Reader:  To view the user’s manuals 
for the scanner and Button Manager, you need to use 
Adobe Reader to open and view the manuals in pdf 
file format.  If you already have Adobe Reader 
installed on your computer, you may disregard this 
item. 

• View Manual:  Click “View Manual” to view or 
print the detailed user manual for the scanner and 
Button Manager respectively. 

 

3. Click Install Button Manager to install the Button 
Manager software and then click Install Scanner Driver 
to install the scanner driver on your computer. 
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2.1.4 Connecting to Computer 
 

1. Connect the square end of the USB cable to the USB port of 
your scanner.  Connect the rectangle end to the USB port of 
your computer. 

 
 

2. The computer should detect a new USB device and prompt 
a “New Hardware Found” message. 

3. In Windows XP, click the Next button to continue. When 
the XP certification screen appears, click Continue 
Anyway to complete the installation. 
In Windows Vista, click the Recommended option, and 
then click Continue button to complete the installation. 

4. When the Finish dialog is prompted, click the Finish 
button.  

5. Click “View Manual” to view or print the detailed user 
manual for the scanner and bundled applications 
respectively. 
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3. Completing Your First 
Scan 
 
 
 

3.1 Loading Your Paper 

3.1.1 Notice on Using the ADF 
 
Before using the ADF, please make sure that your paper meets 
the following specifications: 

 

• Document(s) can range in size from 3.5 by 3.5 inches to 
8.5 by 14 inches (Legal). 

• Document(s) can range in weight from 16 to 28 lbs 
(60~105 g/m2) 

• Document(s) should be square or rectangular and in good 
condition (not fragile or worn). 

• Document(s) should be free of curl, wrinkle, tears, wet 
ink, or punch holes. 

• Document(s) should be free of staples, paper clips, paper 
sticky notes. 
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3.1.2 Placing Your Document in the ADF Paper Tray 

Fanning Your Document 

Standard paper size should feed easily through the scanner. 
To avoid occasional paper jam when automatically feeding 
multiple documents, loosen the paper before loading.   

 

Document Feeding 

 
1. Raise the ADF paper tray to about 45 degrees and pull the 

tray extension. 
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2. Place your document with the text face up and make the 

top of the page point to the document feeder as shown 
below. Center your document with the paper guides and 
make sure the edge of document touch the paper guides. 

 

 

3.2 Placing paper on the document glass 

Place your document face down on the document glass and 
align the document to the reference mark as indicated.  
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3.3 Verifying Your Scanner Installation   

 
To verify if your scanner installation is correct, Avision provides 
you a useful test program called Avision Capture Tool.  With 
this tool, you can perform simple scans and view the captured 
images.  In addition, it helps you complete your scan at a rated 
speed. 
 
The following procedure describes how to verify your scanner 
installation.  If the installation is not correct, please review the 
preceding section to check if the cable connection and scanner 
driver have been successfully installed.    
 
Before you begin, be sure the scanner is on. 
 
1. Select Start>Programs>Avision AVxxx Scanner>Avision 

Capture Tool. 
The Select Scanner Model dialog box will be displayed.  

 
 

2. Select your driver type and scanner model and click OK.  
The following Avision Capture Tool dialog box will be 
displayed. 
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Setup    

Fit 
Page 

Scan 
File Format 

Save       File Path 

Actual  
Size

 
 
3. Choose your desired file format from the File Format drop 

down list box. (Default is BMP, other choice includes TIFF, 
GIF, and JPEG.) 

4. Type your desired folder name and file name in the File 
Path box. (Default is C:\My Scan\Image.) 

 
Note: If you do not wish to save the scanned image, 
deselect the Save button since default is Save Enable. In 
this case, the thumbnail view will be disabled.  And 
therefore, after viewing all the scanned images, only the 
last one will remain on the screen.   

5. Click the Setup button ( ) or choose Setup from the 
File menu to prompt the Scanner Properties dialog box. 
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Image 
Selection 

Box 

 
6. From the Image Selection Box, choose your desired 

image type for your scanned image.  (Default is Front 
B&W)  If you have a duplex scanner, choose Front and 
Rear to scan both sides of your document.  

7. Click OK to quit the Scanner Properties dialog box.  (To 
learn more details about the Scanner Properties dialog 
box, please see the subsequent chapter, Using the 
Scanner Properties Dialog Box.) 

8. Place your document face down on the document glass 
or face up in the auto document feeder. 

9. In the Scan Validation dialog box, click the Scan button 

( ) or choose Scan from the File menu. 
10. The document will be scanned and displayed in the Scan 

Validation screen.  After the scanned images have been 
displayed, your scanner installation verification is 
completed.  
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Fit Page View Status Bar  

Thumbnail View  
 

11. You can view the scanned image in Fit Page ( ) or 

Actual Size (100%) button ( ) from the Viewing 
toolbars at the right side. 

12. Click the Close box or Quit from the File menu to exit the 
Scan Validation Tool. 
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3.4 A Glance of the User Interface 

 

 

1 

2 

3 
4 
5 
6 

7 

8 

 
1. Tab Options Choice:  Image, Compression, Color Dropout, 

Paper, Options, Settings, Information. 
2. Image 

Selection 
Box    

Choose your image type and the side of 
document you wish to scan.  Options vary 
based on type of scanner.  

3. Brightness: Adjust the brightness level from –100 to 
+100.   

4. Contrast Adjust the contrast level from –100 to +100. 
5. Resolution Determine the quality of the scanned image.  

The industry standard is 200 dpi. 
6. Invert Reverse the color of your scanned image. 
7. Scan Source  Choice: Auto Document Feeder, Flatbed, 

Flatbed (Book), Automatic (This option varies 
due to different scanner model)  

8. Defaults Reset all values on the tabs to the factory 
default settings. 
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4. Using the Scanner 
Properties Dialog Box 
 
 
 
 
The Scanner Properties dialog box allows you to configure the 
scanner’s settings. It consists of several tabbed windows each 
of which will be described in this chapter. 
 

 
 

The Scanner Properties dialog box 
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4.1 Buttons on the Scanner Properties Dialog Box  

 

The buttons on the Scanner Properties dialog box 
 

Buttons Description 

Defaults Click the Defaults button, the factory default 
settings will be shown on each tab.   

Scan After all the scan settings are satisfactory, click 
the Scan button to start scanning your 
document. 

Close Click the Close button to leave the Scanner 
Properties dialog box. 
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The following table shows the default settings： 
 
Tab name Default settings 
Image Image：Front B&W 

Binarization：Dynamic Threshold 
Resolution：200 dpi 
Invert：Blank on White 
Scan Source：Auto Document Feeder 
Threshold：None 
Brightness：None 
Contrast：None 

Compression None 

Color Dropout None 

Paper Cropping：Automatic 
Deskew：Yes 
Orientation：Portrait 
OverScan：0.00  
Multi-feed Detection：None 
Unit：Inch 

Options Rotation Degrees：None 
Blank Page Removal：None 
Edge Fill：White，0 mm 
Image Control Option：None 

Setting Enable Energy Saver：Enable, 15 
minutes after last scan action 
Show Scanning Progress：Yes 
Show Warning Message：Yes 
Save Settings after Closing：Yes 
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4.2 The Image Tab  

The Image tab allows you to choose the front side and (or) the 
rear side of your document, the type of image, and to set 
several basic scan settings.  Note that except for the resolution, 
you can set individual scan settings for the front side and the 
rear side.  For example, all settings in the Image tab, 
Compression tab, Color Dropout tab can be set individually for 
the front and the rear side.  However, the settings in the Paper 
tab, the Option tab, and the Setting tab have to be set the 
same for the front and rear side.   
 

 
 

The Image tab dialog box 
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4.2.1 The Image Selection Box 

 

The Image Selection box includes the 
image type and document side option.  
If you wish to scan both the front side 
and the rear side of your color 
document, you can check both Front 
Color and Rear Color at the same time.  
Note the options vary based on type of 
scanner. 

 
Example 1：Scanning a two-sided color document, both 
sides in color 

 
 

Side/Image 
Selection 

 
Front  

Rear 
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Example 2：Scanning a two-sided color document, one 
in B&W(Drop Blue Color：Threshold：10, Background：
79), the other in color 

 

 

Side/Image 
Selection 

 

Front 

 

Rear 

 

Image Type Description 
Color Choose Color if you wish to scan a color image

for your original in color.  
Gray Choose Gray image if your original contains 

actual shades of gray. 
B&W Choose B&W if your original contains only text

pencil or ink sketch. 

   
B&W Gray Color 
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Front/Rear Auto Color Detection:  

Click to automatically detect and scan the front or the rear 
page of your color document in color image mode.  If your 
document is in colors, the scanner will automatically scan the 
document into a color image.  If your document is non-color, 
you can choose the output to be either B&W or Gray from the 
Non-Color Selection option.  This option is useful when you 
have a mixture of color and non-color document. 

Note:  If you choose Front Rear Auto Color Detection, you can 
not specify the image mode of your rear page and vice versas. 
 

 
 

Sensitivity of Auto Color Detection 
 
If your documents contain primarily B&W text and small 
amount of light or pale colors and you do not wish them to be 
recognized as color image to save the file size, you can reduce 
the sensitivity value by moving the bar to the left to let these 
images to be detected as B&W. The value ranges from 1 to 30.  
The default is 20. 
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4.2.2 Other Image Options 

Binarization This is the process of converting a 
grayscale or color image to a bi-tonal 
image. There are several different 
methods of performing this conversion.  
Options:  Dynamic Threshold, Fixed 
Processing, Halftone 1~5, Error 
Diffusion. 

Dynamic Threshold:  Selecting 
Dynamic Threshold allows the scanner 
to dynamically evaluate each document 
to determine the optimal threshold value 
to produce the highest quality image.  
This is used to scan mixed document 
containing faint text, shaded background, 
or color background with a single setting.  
If Dynamic Threshold is selected, 
Threshold, Brightness, and Contrast are 
not available. 
 
Sensitivity of Dynamic Threshold 
 
Occasionally your scanned image may 
contain small dots or speckles. To remove 
these spots, increase the sensitivity value 
by moving the bar to the right. The value 
ranges from 1 to 30.  The default is 20. 
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 Fixed Processing:  Used for black-and-

white and other high contrast documents.  A 
single level is set to determine the black-
and-white transition. The threshold is 
programmable over the entire density 
range.  Fixed Processing sets Contrast to 
0.  If Fixed Processing is selected, 
Contrast is not available. 

 
 Halftone:  In addition to the black and 

white display, Halftone can present a 
somehow gray shade of image by using 
different size of dots.  Halftone image looks 
like the picture we have seen in the 
newspaper.  Options include Halftone 1, 
Halftone 2, Halftone 3, Halftone 4, 
Halftone 5.  
 
Error Diffusion:  Error Diffusion is a type 
of Halftone.  Error Diffusion gives good 
image texture and makes text in images 
more readable than Halftone. 
 

 
Halftone Image 

 
 

 

 4-9 



 
 
 
 
 

 
Error Diffusion Image 
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Threshold Used to convert a grayscale image to a  

bi-tonal image. The value ranges from 0 to 
255. A low threshold value produces a 
lighter image, and can be used to subdue 
backgrounds and subtle, unneeded 
information. A high threshold value produces 
a darker image, and can be used to help pick 
up faint images.  
Adjust the threshold setting by dragging the 
Threshold sliding bar to the left or right to 
achieve the desired threshold setting. 
 

 
 
200 dpi, 
Threshold:80, 
Brightness: 0 

 
 
200 dpi,  
Threshold:170, 
Brightness: 0 
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Gray  
Document Type:  Choice:  Normal, Photo, Document   
Three options of document type are provided when you choose 
Gray as the image type for your scanned document.  Choice:  
Normal, Photo, Document.  

• Document: Choose Document if your original contains 
pure text or a mixture of text and graphic since it is an 
optimal setting for regular business document.  When 
using Document, only Threshold can be adjusted.   

• Photo: Choose Photo if your original contains photo to 
reproduce your photo in vivid grayscale image.  When 
using Photo, no Threshold and Contrast can be adjusted. 

• Normal: When using Normal, Threshold, Brightness, and 
Contrast can be adjusted.  

 
Threshold:  The value ranges from 0 to 255.  The default is 
230.  A low threshold value produces a lighter image, and can 
be used to subdue backgrounds and subtle, unneeded 
information. A high threshold value produces a darker image, 
and can be used to help pick up faint images. Adjust the 
threshold setting by dragging the Threshold sliding bar to the 
left or right to achieve the desired threshold setting. 
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Normal 

 
Photo 

 
Document 
(Threshold: 230) 
 

 
Normal 

 
Photo 

 
Document 
(Threshold: 230) 
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Brightness Adjusts the lightness or darkness of an 
image.  The higher the value, the brighter 
the image.  Drag the slider to the right or 
left to increase or decrease the brightness.  
The range is from –100 to +100. 

Contrast Adjusts the range between the darkest and 
the lightest shades in the image.  The 
higher the contrast, the bigger the different 
grayscale. Drag the slider to the right or 
left to increase or decrease the contrast.  
The range is from –100 to +100. 
 

   
Brightness: -50 Brightness: 0 

(Normal) 
Brightness: +50 

   
Contrast: -50 Contrast: 0 

(Normal) 
Contrast: +50 
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Resolution A good control of the resolution results a 

good detail of an image that scans.  The 
resolution is measured by dots per inch 
(dpi).  Normally, the greater the dpi number, 
the higher the resolution and the image file 
size.  Be aware that greater resolution takes 
more time to scan, and more disk space for 
the scanning image.  For your information, 
an A4 size color image scanned at 300 dpi at 
True Color mode consumes approximately 25 
MB of disk space. A higher resolution 
(usually means over 600 dpi) is only 
recommended when you need to scan a 
small area at True Color mode.  

Choose a resolution value from the drop 
down list. The default value is 200 dpi. 
Available resolutions are 75, 100, 150, 
200,300, 400 and 600. Or you may choose 
your desired value by clicking the box in the 
right side of the drop down list and press the 
arrow key to select your desired value and 
then click the Add button to include it in the 
drop down list. Note:  The resolution is up to 
300 dpi if an imprinter or a MICR reader is 
installed or connected to the scanner. 

 
Resolution: 75 dpi  

Resolution: 150 dpi 
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Invert Reverses the brightness and the colors in the 

image.  The default setting is Black on a White 
background.  Reverse mode is White on a Black 
background. For color images, each pixel will be 
changed into its complementary color at the 
command of Invert. 
 

 
Black on White 

 

 

White on Black  
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Scan 
Source 

Choice: 
 Auto Document Feeder:  Used to scan 

multiple pages. 
 Flatbed:  Used to scan a single page. For 

example, pages from newspaper clipping, 
paper with wrinkles or curls.  

 Flatbed (book):  Used to scan several 
inside pages from book. 

 Automatic:  Allow the scanner automatically 
set its scan source.  If Automatic is selected 
and there is document in both the auto 
document feeder (ADF) and the flatbed, then 
the scan source will be automatically set to 
ADF.  If Automatic is selected and there is 
document only in flatbed, then the scan 
source will be set to flatbed. 

 Merge Two Sides into One Image:  
If you have a sheet-fed duplex scanner with 
front input tray, you can scan an A3 size 
document with an innovative method.  Thus, 
fold your A3 size document into A4, and then 
load the paper in the front tray.  Choose 
Merge Two Sides from the Scan Source 
option and then the scanner is able to scan 
both sides of your document and merge two 
A4 images into one A3 image.  

 
When you select Merge Two Sides into One 
Image, the Cropping or Multi-feed function 
will be disabled. 

 
Note the options vary based on type of 
scanner. 
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Color 
Matching 

 

The purpose of Color Matching is getting the 
accurate color. This option uses the default 
parameters (ICC profile) to adjust the colors 
of the image.  

Choice: None, Document, Photo 
• None: Choose “None” to disable this 

option. 
• Document: Choose “Document” if your 

original contains pure text or a mixture of 
text and graphic since it is an optimal 
setting for regular business document.     

• Photo: Choose “Photo” if your original 
contains photo to reproduce your photo 
in vivid color image.  

 

            
                        Normal 
 

           
                 After Color Matching 
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4.2.3 Scanning color images 

The following options are available for scanning color images.  

 Brightness 
 Contrast 
 Resolution 
 Invert 

 

4.2.4 Scanning grayscale images  

The following options are available for scanning gray images.  

 Brightness 
 Contrast 
 Resolution 
 Invert 

  

4.2.5 Scanning B&W images  

The following options are available for scanning B&W images.  

 Binarization (Dynamic Threshold) 
 Resolution 
 Invert 
 

Or 
 Binarization (Fix Processing) 
 Threshold 
 Brightness 
 Resolution 
 Invert 
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4.2.6 Editing Profiles 

 
The Scanner Properties dialog box allows you to change and 
save your frequently used scan settings into a profile.  You can 
edit these profiles by renaming or deleting them.  
 
To add a new profile, 
 
1. Customize your settings.  (For example, change your 

resolution, image type, cropping method, scan size, or 
other scan settings.)  

2. Click the Image tab and then choose “Profiles” to prompt 
the “Edit Your Profile” dialog box.  

 
 
3. Click “Add” to enter the name of the profile and then 

choose “Save”. 

 
 
4. The new profile will be saved and shown in the “Profiles” 

dropdown list box.  
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To load a profile,  
 
 
1. From the Image tab dialog box, choose your favorable 

profile from the “Profiles” dropdown list box. 

 

2. Your favorable profile will be immediately loaded and 
displayed on Scanner Properties dialog box. 

 
 
To delete a profile, 
 
1. From the Image tab dialog box, click “Profiles” to prompt 

the Edit Your Profile dialog box. 

 
 
2. Choose the profile you want to delete from the dropdown 

list box. 
3. Click “Delete”.  A Confirm message “Are you sure you 

want to delete this profile?” is prompted. 
4. Choose “Yes” to delete or “Cancel” to quit. 
 

 4-21 



 
 
 
To rename a profile, 
 
 
1. From the Image tab dialog box, click “Profiles” to prompt 

the Edit Your Profile dialog box. 

 
 
2. Choose the profile you want to rename from the dropdown 

list box and then click the Rename button. 
 
3. Enter new name for the profile. 

 
 
4. Choose “Save” to save the new profile or “Cancel” to quit. 
 
Note: 
The preset default profiles include Flatbed, Simplex-B&W, 200 
dpi, Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi, Duplex-
B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 200 dpi.  If 
you have a simplex or a sheetfed scanner, the duplex or the 
flatbed option will not be available. 
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4.3 The Compression Tab 

The Compression tab allows you to compress your scanned 
image and choose the level of compression.  Bi-tonal images 
are normally compressed using CCITT standard called Group 4 
(G4).  Color and grayscale images are often compressed using 
JPEG technology.  Move the JPEG Quality slider to the right or 
left to increase or decrease the level of compression.  Note the 
greater the compression level, the lower image quality.  Default 
is 50%. 

 
Note that the compression depends on your image editing 
application.  If your image editing application does not support 
the type of compression format, then  either a warning 
message will appear or the image quality of the compressed file 
will not be acceptable.  
 
JPEG (Joint Photographic Editor Group).  This group developed 
and lent their name to a file compression standard for color and 
grayscale images that is widely used by scanners, and software 
applications.  On Microsoft Windows-based systems, a file with 
the extension .jpg has normally been compressed using this 
standard. 

 
For scanning color or gray images, the following compressions 
are available: 

 None 
 JPEG 

 
For scanning B&W images, the following compressions are 
available: 

 None  
 G4 
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The Compression tab dialog box 
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4.4 The Color Dropout Tab   

4.4.1 Color Dropout Selection 

Color Dropout tab allows you to drop either of the red, blue, or 
green color in your scanned image.  If your image contains red 
color watermark or background, choose the R (Red) channel 
then any red watermark or background will be removed.  This 
feature is used to sharpen your text when using OCR (Optical 
Character Recognition) software.   

The “Custom” option allows you to specify your desired color to 
be removed by entering its RGB (Red, Green, and Blue) value 
respectively.  
 
Tolerance: Specify the allowable color range to be removed for 
the color you selected. Specified range: 1 ~ 100  
The large the numeric value, the wider the color dropout range 
is.  
 
Note that this function supports only black & white and gray 
images.  Therefore, be sure to choose any black & white or 
gray image type while applying this function. 
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The Color Dropout dialog box 
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4.4.2 Other Color Dropout Options 

 
Advanced Processing provides two options that can adjust 
your scanned image in the best optimal result. 
 
Filter 
Threshold 

This value is used to determine the color 
which will be dropped out.  A lower value will 
drop more of the selected color out, while a 
higher value will leave more of the selected 
color in. 

Background 
Level 

The pixel which is higher than the 
background value will be adjusted to the 
lightest point.  Adjust the value for both the 
Filter Threshold and Background Level to 
produce the best optimal result. 
 

Example, slightly adjusting the background value makes 
your text more clear.  
 

 
Original 
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Remove Blue, Threshold: 20, Background: 
255 

 
Remove Blue, Threshold: 20,  
Background Level: 210 
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4.5 The Paper Tab  

The Paper tab allows you to define values relating to image 
output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed 
Detection).  
 

 

The Paper tab dialog box 
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4.5.1 Cropping  

Cropping allows you to capture a portion of the document 
being scanned.  Choice:  Automatic, Fixed to 
Transport, EOP (End of Page) Detection, Automatic 
Multiple, Relative to Documents. 

 
Options Description 

Automatic Automatic adjusts the cropping window 
according to different document sizes. Use 
this option for batches of mixed-sized 
documents. 

Fixed to 
Transport 

This feature allows you to define the area 
or zone to be imaged.  Use for batches of 
same-sized documents.  If you select this 
option, you can use the arrow keys to 
define the x and y offset values, width and 
length to redefine your scanned area.  The 
Display window will show image placement 
as you change the values. 

EOP (End of 
Page) 
Detection 

This feature allows you to define the area 
or zone to be imaged.  Use for batches of 
same-width but different length 
documents.  If you select this option, you 
can use the arrow keys to define the x and 
y offset values, width and length to 
redefine your scanned area.  The Display 
window will show image placement as you 
change the values. 
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Automatic 
Multiple 

This option allows you to place various 
sized documents such as photos, ID Cards, 
or business cards on the flatbed (if 
available) and lets you create multiple 
individually cropped images in one scan. 
Note: To correctly create multiple images, 
please make sure there is at least 12mm 
(0.5”) of space between each document. 

Relative to 
Document 

This option allows you to crop different 
areas on your documents and deliver these 
images in B&W, Gray, or Color separately.  
For example, there are applications which 
require you to store the entire document in 
B&W and a part of the document in color to 
save storage space.  This is useful for 
documents where a photograph or 
signature appears in a consistent area on 
the document such as resumes, and so on. 

 

The following options are only available when Fixed to 
Transport is selected.  

 
 X-Offset — the distance from the left end of the 

scanner to the left edge of the scanning area.  
 Y-Offset — the position from the top end of the 

document to the top end of the scanning area.  
 Width — the width of the scanning area.  

 Length — the length of the scanning area.  

 Center: automatically calculates the x-offset for center-
fed feeding based upon document size selected. 

 — relocate the scan area by click the arrow key on 
the cross sign while retain the scan size.  View the result 
from the Display window.   
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Relative to Document: (used for batches of same-sized 
documents) 

This option allows you to crop different areas on your 
documents and deliver these images in B&W, Gray, or Color 
separately.  For example, there are applications which require 
you to store the entire document in B&W and a part of the 
document in color to save storage space.  This is useful for 
documents where a photograph or signature appears in a 
consistent area on the document such as resumes, and so on.   
 
The following procedure describes how to reproduce the entire 
document in B&W and a portion of document (picture) in color.   
 
1. On the Paper tab, choose “Relative to Document” or “Fixed 

to Transport” from the Cropping option. 

2. Choose your scan size from the Scan Area option.  The 
selected scan size will be displayed in a red rectangular 
box.  This is also the scan size of your entire document. 
(For example, ISO B5.  If you have not chosen a scan area 
and leave the selection as None, then the default area will 
be the scanner’s maximum.)  

 

1 

2 A red 
rectangular 
box 
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3. Click the Preview tab to display the Preview window.  A 

black rectangular box appears to indicate the max. scan 
size your have just selected. 

 

The Image 
Selection 

Box 

The selected 
image  

A black 
rectangular 
box 

 
4. Click the Preview button to view the entire image in low 

resolution to correctly crop your relative scan area.  

 

The Preview 
Image 

The Preview 
Button 

5. Select image type from the Image Selection box.  The 
selected image will appear in highlighted color. (For 
example, Front Color) 

6. Place your cursor on the Preview window and click your 
left mouse button.  A cross sign will appear as illustrated.  
Create your relative scan size diagonally by dragging the 
left mouse button to your preferable size.  The selected 
area will appear in a red box as illustrated.  
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A Cross 
Sign 

 

The 
Relative 
Area  

7. Check the B&W image from the Image Selection box to 
scan the entire document. 

8. Click the Scan button to start scanning the document in 
two image types and sizes.  (See the result in below.)  

   
   The entire document in B&W     The relative area in color 
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4.5.2 Other Paper Selection 

Deskew 

Use this option to automatically deskew a document.   

  

Note: If the skew angle is 
too great, some of the 
image may be cut off. 

 
 
Scan Area  

Choose your desired paper size with the drop-down list box.  Or 
you may select a custom paper size by clicking the Scan Area 
box and then click Add to include in the choice. 

Choice:  None, US Letter- 8.5”x 11”, US Legal – 8.5” x 14”, 
ISO A4 – 21 x 29.7 cm, ISO A5 – 14.8 x 21 cm, ISO A6 – 10.5 
x 14.8cm, ISO A7 – 7.4 x 10/5 cm, ISO B5 – 17.6 x 25 cm, 
ISO B6 – 12.5 x 17.6 cm, ISO B7 – 8.8 x 12.5 cm, JIS B5 – 
18.2 x 25.7 cm, JIS B6 – 12.8 x 18.2 cm, JIS B7 – 9.1 x 12.8 
cm, Scanner Maximum, Long Page. 

 
Long Page:   
When you need to scan documents whose length exceeds 
scanner maximum, please choose Long Page.  Note if Long 
Page is selected, the Multi-Feed Detection will not be available. 
Options: Unknown Length, Enter Length   (Note: This option 
varies due to type of scanner.)   
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Choose “Unknown Length” if you have a batch of long page 
document with unknown length. Choose “Enter Length” to 
enter the length and width of your documents or your desired 
scan size on documents.  This is useful when you have a batch 
of documents with the same scan size or a batch of same-sized 
documents. 

OverScan 
Overscan allows you to add a specific margin at top and bottom 
or right and left (Options vary based on the type of scanner) of 
the edge of the image.  This is used to reduce possible corner 
clipping on the skewed images and often applied to a batch of 
skewed document to be scanned in the auto document feeder.  
Select a value between 0 and +5 mm.   Note the overscan 
result will not be shown in the Display window and that the 
availability of the function varies based on type of scanner.  
 
 
Pre-Feed 
Choice:  Enable, Disable.  If enable is selected, you can set the 
amount of time the scanner starts pre-feeding your paper after 
your documents has been loaded into the feeder. The default is 
disable. 
 
Transport Timeout 
Set the amount of time the scanner will wait and then start 
auto scan after the first scan job is completed. If you have 
many separate documents need to be scanned at the same 
scan settings, this feature is especially useful. The default is 0.  
The value ranges from 0 to 30 seconds. 
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Note:  
1 Within the specified timeout period, if you load your 

document to the feeder, the scanner starts scanning 
automatically. 

2 If your scanner has a flatbed option and you place your 
paper on the flatbed, after the timeout period, you need 
to click the Scan button on the TWAIN user interface to 
start scanning.  
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4.6 The Multi-Feed Detection Tab 

 
Multi-Feed Detection    

Multi-Feed Detection allows you to detect overlapped document 
that go through the auto document feeder. Multi-Feed usually 
occurs due to stapled documents, adhesives on documents, or 
electro-statically charged document. Note： The availability of 
the function varies based on type of scanner. 
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Additional Length Detection 
Additional Length Detection allows you to define the length of 
document being multi-fed.  This value indicates the additional 
length exceeding your scan area.  The Display window will 
show the size of the document as you change the value.  A 
value of 0 indicates no additional length detection.  The 
Additional Length Detection is best used when scanning same-
size documents in the auto document feeder.   
 
Intelligent Mode (Skip Multi-Feed) By Ultrasonic 
Detection 
Some documents which are glued with a photo or a label may 
easily be detected as multi-feed yet you wish to bypass these 
multi-feed conditions. In this case, you can use the intelligent 
mode to let the scanner memorizes and skips these multi-feed 
conditions. Choice includes Disable, By 
Length(Paper/Object), By Position, By 
Length(Paper/Object)+Position.   
 
By Length (Paper/Object): When a multi-feed is detected 
for the first time, the scanner memorizes both the length of the 
document and the length of the object (photo or label) 
attached to the document. When you perform next scanning, 
this pattern of multi-feed will be bypassed. 

 

By Position: When a multi-feed is detected for the first time, 
the scanner memorizes the position of the photo or label 
attached to the document. When you perform next scanning, 
this pattern of multi-feed will be bypassed. 
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By Length (Paper/Object)+Position: When a multi-feed is 
detected for the first time, the scanner memorizes the length of 
the document, the length and position of the object (photo or 
label) attached to the document. When you perform next 
scanning, this pattern of multi-feed will be bypassed. 

To use the intelligent mode, 

1. Choose your desired multi-feed detecting method to 
bypass by.  

2. When multi-feed occurs during scanning, a multi-feed 
warning message appears. 

3. Choose OK to skip the multi-feed condition from next 
scanning and close the message.  

4. Open your TWAIN data source in your scanning application. 
The same multi-feed condition will not be recognized as 
multi-feed. 

 
 
Note:  
1. You can clear the previous multi-feed conditions by 

clicking the Reset button. 
2. The scanner can memorize to bypass up to 25 multi-feed 

conditions. 
3. If you uninstall your scanner driver, the previous multi-

feed conditions which have been set to memorize and skip 
will still be valid. 
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Detection Area 

This option allows you to specify a multi-feed detection area. 

To specify a multi-feed detection area, 

1. Choose Disable from the Intelligent Mode. The Detection 
Area will be enabled. 

2. Choose Inside the Range or Outside the Range. The 
detection area will be highlighted. 

3. Drag your mouse pointer on the top or the bottom of the 
detection area to specify your area in the display window. 
Or you may use the up and down arrow key of the Top 
and Bottom to change its size. The Top indicates the 
starting position of the detection range. The Bottom 
indicates the ending position of the detection range. Note 
the top value and the detection range has to be at least 1 
inch. 

 

Detection Area: Inside the Range, Box, Top: 3”, Bottom: 7” 
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Detection Area: Outside the Range, Box, Top: 3”, Bottom: 7” 
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Ultrasonic Detection 
 
Ultrasonic Detection  allows you to set overlapped document by 
detecting paper thickness between documents.  Note： The 
availability of the function varies based on type of scanner. 
 
 
There are two options available if Multi-Feed is detected.  

 Stop Scanning after Multi-Feed 

If this is selected, the scanner will stop the feeder and 
display the following Warning dialog box if multi-feed is 
detected. 

 

 

Action:   

1. Follow the instruction on the Warning dialog box to 
remove the rest pages on the feeder. 

2. Click OK to close the Warning dialog box. 

3. Scan the rest pages. 
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 Multi-Feed Alarm  

If a wave file is added, the scanner will make a sound 
alarm if multi-feed is detected yet no Warning dialog box 
will be displayed.   

If “Stop Scanning after Multi-Feed” is selected, the scanner 
will stop the feeder.   

If “Stop Scanning after Multi-Feed” has not been selected, 
the scanner will continue to scan till the end of your 
document. 

Action: 

1. If “Stop Scanning after Multi-Feed” is selected, follow 
the action described in the preceding section “Stop 
Scanning after Multi-Feed” on the previous page to 
complete your job. 

2. If “Stop Scanning after Multi-Feed” has not been 
selected, rescan the pages where multi-feed is 
detected. 

 

How to add the sound alarm： 

1.  Click the Browse button on the right side of the speaker 
icon. The Open dialog box appears.  

2.  Choose your wave file.  

3.  Click the Open button.  The wave file is added.  
 

Units 

Defines the primary measurement system.  Inches, 

Millimeters, and Pixels are available.  
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4.7 The Preview Tab 

 
The Preview tab allows you to preview (a low-resolution scan) 
your image before final scan.  This preview image lets you 
allocate your scan area.  You can choose your scan area by the 
“Scan Area” drop down list box or placing your cursor on the 
Display window and dragging it diagonally on the Display 
window.  Then, a red rectangle box will appear to indicate the 
selected area. 
 
Note:  If you choose “Automatic Cropping” on the “Paper Tab”, 
then to select a scan area on the Preview tab is not allowed. 
 

 

The Display 
Window 

 
The Preview Tab 
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4.8 The Options Tab 

The Options tab allows you to set following additional image 
processing settings.   
 

 

The Option tab dialog box 
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Flip Side 
Rotation 

Select “fanfold” to rotate the image 
of the reverse side to 180 degrees.   

This is applied to double-sided 
document which are viewed in 
portrait are sometime fed into the 
scanner in landscape or vice versa.   

Choice: Book, Fanfold. 

If “Book” is selected, the image of 
the reverse side will not be rotated.  

 
The following illustration shows the documents which should 
be viewed in portrait are fed into the scanner in landscape 
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Rotate Image Choose the rotation angle from the drop 
down list if you wish to rotate your 
scanned image. 

Choice: None, 90°CW(clockwise), 
90°CCW(counter clockwise), 180°, 
Auto based on contents. Auto 
rotate every even page. 

 

Original 
 

Rotate 90°CW 

 
Rotate 90°CCW 

 

Rotate 180° 
 

 Auto based on contents:  When Auto 
based on contents is selected, images 
can be rotated to their proper 
orientations based on their contents. 

Auto rotate every even page: 
Automatically rotate 180° on every 
even page.  This is especially useful 
when you scan the inside pages from a 
book.  As a result, if you choose 
“Flatbed (book)” from the “Scan 
Source” option, “auto rotate every even 
page” will be selected as default.   
 
Note:  This option varies based on 
type of scanner. 
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Blank Page 
Removal 

Check if you wish to remove the blank page 
and move the slider to the left or right to your 
desired threshold.   

 

Edge 
Fill 

 

Check White or Black if you wish to add white or 
black edge on the border of your scanned image. 
Enter the value from 0 to 5 mm.  Default value is 0. 

 
Original 

 
Edge Fill: 5mm (Black) 
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Image 
Control 
Option 

Check the Mirror box if you wish to reverse the right 
and left side of your image. 

 

 
Original 

 

 

 
The Mirror Effect 
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Despeckle 
 
Occasionally small dots or specks appear in the background of 
a scanned image. Remove unwanted speckles provides a 
cleaner image for OCR (Optical Character Recognition) 
processing, and also helps to reduce compressed file size. 
 
Define the speckles (also known as image noise) you wish to 
remove by specifying its number (size) and radius (range). The 
measuring unit is pixel. The higher the number, the more 
speckles will be removed.  
 

 
Before Despeckle  
(noise number:0, noise radius:1) 

 
 

 
After Despeckle  
(noise number:22, noise radius:10) 
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Note:  
• The function is currently available for Black and White 

image only. 
• To scan at rated speed, it is recommended to set the 

noise radius up to 10 pixels. 
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Background 
Setting 

This option allows you to set your scan 
background. Choice: White Background, 
Black Background. 

Note: For a sheet-fed scanner with an auto 
document feeder, this option is currently 
available only in the “Auto crop” mode. For a 
scanner with a flatbed platen, this option is 
available either in the “Auto crop” or the 
“Fixed to Transport” mode.  
 
For details on choosing the “Auto crop” or 
the “Fixed to Transport” mode, please refer 
to section 4.5.1, Cropping. 

 
White Background 

 

 
Black Background 
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4.9 The Setting Tab  

The Setting tab allows you to set the following settings: 

 

 

The Setting tab dialog box 
 
Energy Saving 
Control 

Check the Enable Energy Saver box 
and move the slider to the right to set 
the amount of time to start the energy 
saver after your last action. The range 
is from 1 to 240 minutes.  The default 
is 15 minutes. 
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Cache 
 

Mode: None, Page Number, Memory 
Size.  
This option allows you to assign a specified 
memory size from the available RAM to 
process the image data. By specifying a 
smaller memory size, you can free more 
memory for other applications you are 
running. By specifying a larger memory 
size, you can have more memory to 
process the image data especially when you 
have a large amount of documents needed 
to be scanned.  
 
You can also specify your memory size by 
the page number. For your information, an 
A4 color document scanning at 300 dpi 
consumes approximates 24MB. 

Image Count 
When the selected cache mode is “none”, 
the image count option allows you to assign 
number of pages you need to scan. For 
example, if you wish to scan the first two 
pages, simply move the page slider to 2, 
and the scan action will be stopped when 
the scanning of the first two pages have 
been completed. 

Barcode 
Detection 

Check this option to enable detecting and 
recognizing barcode in your document. 
After the detecting process, an 
avbarcode.ini file will be generated and 
stored in your system drive, for example, 
Windows\avbarcode.ini.  
Note:  The availability of this feature varies 
based on type of scanner. 
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Show Scanning 
Progress 

Check and the scanning progress bar 
will be shown during scanning. 

Show Warning 
Message 

Check to show the warning messages 
such as “ADF pad count exceeds 
50,000 scans (the number varies based 
on type of scanner). Please replace the 
ADF pad and reset the pad count.” 

Save Settings 
after Closing 

Check to save your scanner properties 
settings after leaving the dialog box.  
Next time when you open the Scanner 
Properties dialog box, the previously 
saved settings will be shown. 
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4.10 The Imprinter Tab 

 
The Imprinter tab allows you to print alphanumeric characters, 
date, time, document count and custom message on your 
scanned image if digital imprinter is selected or at the back of 
your document if external imprinter is selected.  
 

 
 
 
Choice:  External Imprinter, Digital Imprinter. If you have 
installed an external imprinter, choose external imprinter. If 
you do not have an imprinter, choose digital imprinter. Note 
External Imprinter provides a vertical and rear-side print 
capability while digital printer provides a horizontal and front-
side print capability. 
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Contents 

Print All Check Print All to automatically print the 
text at all pages of your documents.  
Uncheck Print All to print the text for the 
first page of your documents only. 

Custom Enter your custom text to be included in your 
print string.  

Counter Show the document count for the scan 
session. This value is increased sequentially 
by the scanner.    

 
Date/Time Choose if you wish to include the date and 

time in your print string. 
Format: YYYYMMDDHHSS For example, 
20090402170645-check0001 indicates year, 
month, date, hour, seconds, your custom 
text and the counter. 

Custom 
Font 

Choose your desired font.  
Choice: Normal, Fixed Width 
Fixed Width (Mono spaced) fonts have a 
fixed character spacing. So each character 
occupies the same width. 

 

Advanced 

Font 
Attributes 

Choose your font attributes.  Choice:  
Normal, Underline, Double, and Bold. 
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String 
Orientation 

Choose your string orientation. 
Choice: Normal, Rotated, Vertical, 
Vertical Inversion, 90 degrees CW, 90 
degrees CCW 

 
Normal 

 
Rotated 

 
Vertical 

 
Vertical Inversion 

 
90 degrees CW  

90 degrees CCW 
 
If you check the digital imprinter to stamp 
text on your scanned image, the illustration of 
normal and rotated string is shown below: 

 
Normal 

 
Rotated 
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Print 
Position 

Choose the position you wish to print your 
string. Move the slider to the right to increase 
the value or to the left to decrease the value. 
Range: 0~355mm, default:0 mm 
The value indicates the height from the 
bottom of your paper to the last letter of your 
string. This option is available only if an 
external imprinter is installed. 
 
 
 
 
 
 
 
 
 
 

0001abc 2010   The value of 
Print Position 

 

 

Print Position (for digital imprinter) 
Choose the position of your printed string. Choice: Top, 
Middle, Bottom, Custom. If Custom is selected, enter the X 
and Y offset value to specify the position. 
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4.11 The Information Tab  

The Information tab displays the following system and scanner 
information.  

 
 

The Information tab dialog box 
 
 

The “Report” button： 

If you encounter any error message while using the scanner, 
click the Report button.  A report.txt file (C:\AVxxx) will be 
generated.  Please send this file to the nearest service center 
for trouble shooting.   
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The “Reset Pad Count” button： 

After scanning approximately 50,000 pages (the number varies 
based on type of scanner) through the Auto Document Feeder 
(ADF), the ADF pad may be worn out and you may experience 
problems with document feeding.  In this case, it is highly 
recommended to replace the ADF pad with a new one. (Please 
refer to the manual for proper replacing procedure.)  For 
ordering the ADF pad, please consult your nearest dealer.  
After replacing the ADF pad, click the “Reset Pad Count” 
button to reset the pad count.  

 

The “Reset Roller Count” button： 

After scanning approximately 200,000 pages (the number 
varies based on type of scanner) through the ADF, the ADF 
roller may be worn out and you may experience problems with 
document feeding.  In this case, it is highly recommended to 
replace the ADF roller with a new one. (Note the replacement 
of the ADF roller has to be performed only by authorized 
service center.  Therefore, please return your scanner for roller 
replacement.)   After replacing the ADF roller, click the “Reset 
Roller Count” button to reset the roller count. 

Note： 
The lifetime and the replacing procedure vary based on type of 
scanner.  Please consult your nearest dealer for more details.   
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5. ISIS Interface Operation 
 
 
 
 
 
The ISIS driver operation method is similar to the TWAIN’s. 
Every function on the ISIS interface screen is briefly described 
as below: 
 

 
 
 
Mode: Select one of scan modes, including B&W, gray, color 
options. 

Dither: 5 halftone levels available, can be disabled. 

Dots per inch: Select your desired resolution. 

Paper Size: Select your desired paper size. 

Brightness: Adjust your scan image brightness or darkness. 

Contrast: Adjust the range between the darkest and the 
lightest shades in the image. 

Default: Click to reset all settings. 

Area: Select your desired scan area or position. 
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6. Scanning with The 
Buttons  
 
 
 
 
The convenient buttons on the scanner is shown as below: 

 

 
 

 
 

6.1 Installing Button Manager 

To use the buttons on the scanner, you need to install the 
Button Manager.  To ensure the Button Manager work properly, 
please FIRST install Button Manager before installing the 
scanner driver. 
 
Installing the Button Manager is easy.  Insert the supplied CD 
to your CD-ROM drive and follow the instructions on the screen 
to complete the installation of the Button Manager. 

 
Button Manager provides you an easy way to scan your 
document and then link the scanned image to your designated 
software application.  All this can be done by a simple touch of 
the button on the scanner. Yet, before you scan, it is 
recommended to check the button configurations first to ensure 
a proper file format and a destination application.   

Function Selector 

 
Function Display 

The Scan Button 

The Cancel/Stop Button 
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6.2 Checking the Button Configurations Before Scanning 

1. Click the Scan button on the scanner. 

2. The Button Panel is displayed in the Windows System Tray 
at the bottom right corner of your computer screen.  

 
 This indicates the scanner model  

 

The Function 
Icon 

(The number of 
function icons 
vary based on 
type of 
scanner.) 

The Button 
Icon

The Button Panel 
 
 
3. The Button Panel shows the first five scanning buttons.  

Right-click the button (function) you wish to check.  The 
Button Properties window appears. 
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Click to select 
options or 
setting. 

 

 

The button 
number and 
name. 

The scan 
settings for the 
selected 
button.  

 
 

The file 
format of the 
scanned 
image. (*The 
options vary 
based on 
type of 
scanner.) 

The destination 
application. 
(This is the 
application that 
opens after you 
have finished 
scanning.) 

 
 

If you wish to change the setting, use this window to reset 
the setting for the file format, destination application, or 
other scan settings.   
 

4. Click the OK button to leave the window.  
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6.3 Scanning From One Touch of the Buttons   

1. Place your single-page document on the flatbed glass or 
your multi-page document in the auto document feeder.   

2. Check the button number on the LCD-display to ensure if 
you are selecting the proper scan settings and destination 
application. (For example, if you wish to scan with button 
#4, which open Microsoft Paint and display the scanned 
image in the main window of Microsoft Paint, the LCD-
display shows “Custom”).  

3. Press the Scan button on the scanner. 

4. After the scanning is finished, the Microsoft Paint software 
will be launched and the scanned image appears in the 
main window of Microsoft Paint as below.  

 
 
Note: 
1. For details information on how to use the Button Manager, 

please refer to the user’s manual in the supplied CD. 
2. You may also using Button Manager on your desktop by 

starting Button Manager from All Programs or double 
clicking the Avision Scanner Utility from the Control Panel. 
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7. Scanning and Saving Your 
Images to a USB Flash Drive 
 
 

fter inserting the USB flash drive into the USB flash drive port 
t the back of the scanner, this product allows you to start 

B flash drive port at the 
back of the scanner as shown in below:  

 
 
A
a
instant scan immediately and save the scanned images directly 
to a USB flash drive without the need of a computer.  

7.1 Connecting a USB Flash Drive 

Insert your USB flash drive into the US
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7.2 Starting an Instant Scan 

 
1. Make sure your scanner has been turn on and a USB flash 

drive has been inserted to the scanner. 

2. The LCD-display of the scanner shows “Select mode” as 
illustrated in below. Choice includes PC, Network, and USB 
disk.  

Select mode 
PC 

 

3. Press the Arrow key repeatedly until “USB disk” is 
displayed. 

Select mode 
USB disk 

 

4. Press the Enter key to confirm your selection. The LCD-
display shows the following profile option. Choice includes 
Document, Photo, Setting. Predefined settings of 
“Document” mode: 200 dpi, color, PDF, letter size; “Photo” 
mode: 200 dpi, color, JPEG, 4”x6”. If you wish to scan 
different size, select the “Setting” option. 

Select profile 
Document 

5. Press the Enter key to confirm your selection. 

6. The LCD-display shows the “Simplex/Duplex” option. 

Simplex/Duplex 
Simplex 

7. If you wish to scan the front and the rear page of your 
document from the auto document feeder, press the 
Arrow key repeatedly until “Duplex” is displayed. (If you 
wish to scan only one side of your document from the 
document glass, choose “Simplex”.) 
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8. Press the Enter key to confirm your selection. 

9. The LCD-display shows “Ready to scan”. Place your 
document in the scanner. 

Ready to scan 
Back 

 
10. Press the Scan button on the scanner. 

11. The scanner starts scanning and your scanned image will 
be saved into your USB Flash Drive.  

 

Note： 
1. If “Document mode” is selected, a main folder with its 

sub-folder titled “DCIM\DOC” will be created on your USB 
flash drive. Up to 9,999 PDF files can be stored in the 
folder. Each PDF file will be named with a prefix of “DOC” 
and followed by a 4 digit serial number. For example, 
DOC0001.PDF, DOC0002.PDF。) 

2. If “Photo mode” is selected, a main folder with its sub-
folder titled “DCIM\PHOTO” will be created on your USB 
flash drive.  Up to 9,999 JPEF files can be stored in the 
folder. Each JPEG file will be named with a prefix of “IMG” 
followed by a 4 digit serial number. For example, 
IMG0001.jpg, and IMG0002.jpg。) 
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7.3 Viewing the Menu Map 

Please see complete menu map of the “USB disk” mode: 
 
When “USB disk” and “Setting” are selected 
subsequently: 
 

Select mode 

*PC 

USB disk       

Network 

    
 

Select profile 

*Document  

Photo 

Setting                  

Back              

 
 

Setting menu 

*Document mode 

Photo mode 

Back 

Document 

mode 

*Color/Gray 

Select size 

Photo mode 

Select size 

Back 

Select size 

Back 

5”x7” 

*4”x6” 

Select size 

*ADF size 

Flatbed size 
Back 

Back 

A4 

*Letter 

Flatbed size 

Back 
Legal 

A4 

*Letter 

ADF size 

Back 
Gray 

*Color 

Color /Gray 
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When “USB disk” and “Document” are selected 
subsequently: 
 

Select mode 

*PC 

USB disk       

Network 

    
 
 

Select profile 

*Document            

Photo  

Setting                  

Back              

 
 
When “USB disk” and “Photo” are selected 
subsequently: 
 

Select mode 

*PC 

USB disk       

Network 

    
 

Select profile 

*Document 

Photo                     

Setting                  

Back              

Exit 

Ready to scan 

Back 

Simplex 

Duplex 

Back 

Simplex/Duplex 

Exit 

Back 

Ready to scan 

 
Back: Go back to last menu. 
Exit: Go back to the start-menu. 
*: Indicates the default settings. 
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7.4 Changing Your Scan Size 

 
If you wish to customize the scan settings such as changing the 
photo size to 5”x7”, please follow these steps: 
 
1. Make sure your scanner has been turn on and a USB flash 

drive has been inserted to the scanner. 

2. The LCD-display of the scanner shows “Select mode” as 
illustrated in below. Choice includes PC, Network, and USB 
disk.  

Select mode 
PC 

 

3. Press the Arrow key repeatedly until “USB disk” is 
displayed. 

Select mode 
USB disk 

 

4. Press the Enter key to confirm your selection. The LCD-
display shows the following profile option. Choice includes 
Document, Photo, Setting.  

Select profile 
Document 

5. Press the Arrow key repeatedly until “Setting” is 
displayed.   

Select 
profile 

Setting 
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6. Press the Enter key to confirm your selection. The LCD-
display shows the following option. Choice: Document 
mode, Photo mode.   

Setting menu 
Document mode 

7. Press the Arrow key repeatedly until “Photo mode” is 
displayed.   

Select profile 
Photo mode 

8. Press the Enter key to confirm your selection. The LCD-
display shows the “Select size” option.  

Photo mode 
Select size 

9. Press the Enter key to confirm your selection. The LCD-
display shows the “Size” option. Choice: 4”x6”, 5”x7”. 

Select size 
4”x6”* 

10. Press the Arrow key until “5”x7”” is displayed.   

Select size 
5”x7” 

11. Press the Enter key to confirm your selection. The LCD-
display shows the option has been selected with an 
asterisk mark.   

Select size 
5”x7”* 
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12. Press the Arrow key repeatedly until the LCD-display 
shows the “Back” option.   

Select size 
Back 

13. Press the Enter key to return to the previous menu item. 
The LCD-display shows the previous option.   

Photo mode 
Select size 

14. Press the Arrow key repeatedly until the LCD-display 
shows the “Back” option.   

Photo mode 
Back 

15. Press the Enter key to return to the previous menu item. 
The LCD-display shows the previous option. 

Setting menu 
Photo 

16. Press the Arrow key repeatedly until the LCD-display 
shows the “Back” option.   

Setting menu 
Back 

17. Press the Enter key to return to the previous option. The 
LCD-display shows the previous option.   

Select profile 
Setting 

18. Press the Arrow key until “Photo mode” is displayed.   

Select profile 
Photo  
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19. The LCD-display shows “Ready to scan”. Place your 
document in the scanner. 

Ready to scan 
Back 

 
20. Press the Scan button on the scanner. 

21. The scanner starts scanning and your scanned image will 
be saved into your USB Flash Drive.  

Note： 
Follow the similar steps to change other scan settings. 
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8. Care and Maintenance 
 
 
 
 

8.1 Cleaning the Glass 

The procedures  

1. Wet a soft lint-free cloth with some isopropyl alcohol. 
(95%) 

2. Open the ADF unit and document cover as shown below.  
Wipe the glass of flatbed. 

3. Close the ADF unit and document cover. Your scanner is 
now ready for use. 
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8.2 Cleaning the ADF  

 
The scanner parts may be contaminated with ink, toner 
particles or paper coatings.  As a result, the scanner needs to 
be cleaned occasionally particularly in the following cases: 

1. Documents do not feed smoothly or easily; 

2. Several documents feed at one time. 

The cleaning procedures  

1. Wet a soft lint-free cloth with some isopropyl alcohol. 
(95%) 

2. Open the front ADF unit as shown below and wipe the upper 
feeding roller.  Rotate the roller forward with your finger 
and repeat the above cleaning procedures until the entire 
roller is cleaned.  Be careful not to snag or damage the pick 
springs. 

3. Wipe the pad in the direction from top to bottom.  Be 
careful not to hook the pick springs. 

4. Close the front ADF unit. 

5. Open the document cover and then the bottom of the ADF 
unit. 

6. Wipe the rollers until the rollers are cleaned.  

7. Close the document cover and the bottom of the ADF unit.  
Your scanner is now ready for use. 
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ADF 
Roller 

ADF 
Pad 
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8.3 Replacing the ADF detachable pad module 

After scanning approximately 30,000 pages through the ADF, 
the pad spring may be worn out and you may experience 
problems with document feeding.  In this case, it is highly 
recommended to replace the pad module with a new one.  For 
ordering the pad module, please consult your nearest dealer 
and follow the procedure in below to replace it.  

Removing Procedure 
 

1. Open the ADF front cover. 
2. Remove the ADF detachable pad module by pulling out 

the upper part of the pad clamp as shown in the figure 
below. 

 

ADF Pad 
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8.4 Replacing the ADF roller 

 
After scanning approximately 200,000 pages through the ADF, 
the ADF roller may be worn out and you may experience 
problems with document feeding.  In this case, it is highly 
recommended to replace the roller with a new one.  Please 
follow these steps to replace and install the ADF roller. 

 
1. Open the ADF front cover.  

2. Move the ADF roller tab up as indicated. 
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3. Hold the roller and slightly move it forward to detach the 

roller. 
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Assembling Procedure 

 
To install the ADF roller, please follow these steps. 

 
1. Insert one end of the ADF roller to its slots and then the 

other end. 

 
 

2. Press down the tab.  If properly installed, a snap-in 
sound could be heard. 
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9. Troubleshooting 
 
 
 
 

If you have problems with the operation of your scanner, 
please check the following troubleshooting hints.  
 
 
9.1 Removing an Abnormal Line on the Scanned 

Image 

If the scanned image appears with abnormal lines on it, clean 
the white strips of the glass as indicated below with a clean 
lint-free cloth. 
 

 

White 
Strips of 

Glass 
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9.2 Clearing a Paperjam 

In the event of a paper jam, follow the procedures below to 
remove the paper: 

 
1. Gently open the ADF front cover to the left. 

 
 

2. Carefully pull the paper out of the ADF unit. 

3. Close the ADF front cover. The product is now ready to 
use. 
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9.3 Frequently asked Questions 

 
Question: Paper becomes jammed during scanning. 

Answer: 1) Open the ADF unit. 
2) Pull out the jammed paper carefully. 
3) Close the ADF unit. 

 
 
Question: More than one sheet of paper was fed into 

the scanner. 

Answer: 1) Open ADF unit. 
2) Remove the multi-fed sheets of paper. 
3) Close the ADF unit. 
4) Flatten the corners and edges; loosen 
the paper before reloading it in the paper 
guide. 
5) Check the feeding roller condition and do 
the cleaning if necessary. 

 
  
Question: Paper becomes skewed in the scanner. 

Answer: 1) Check the feeding roller condition; do 
the cleaning if necessary. 

2) Use the paper guide when feeding the 
paper. 

 
 
Question: The scanned image always comes out to 

be too dark. 

Answer: 1) Use your application to modify the 
Gamma setting to 2.2 and 1.8 for your 
printer and monitor respectively. 

2) Adjust Brightness setting from the 
TWAIN interface to get a brighter image. 
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Question: The scanner works well except for the line 

art, the lines of which seem much thicker 
than the original. 

Answer: Increase the Brightness or adjust the 
Threshold setting to adjust the line art 
image. 

 
 
Question: Paper becomes jammed during scanning. 

Answer: 1) Open the ADF unit. 
2) Pull out the jammed paper carefully. 
3) Close the ADF unit. 
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9.4 Technical Service  

 
Before contact Avision, please prepare the following 
information: 

 
 Scanner serial & revision number (located on the bottom of 

the scanner); 
 Hardware configuration (e.g., your host CPU type, RAM size, 

free disk space, display card, interface card); 
 The name and version of your scanning software application;  
 The version of your scanner driver.  

Please call us at: 
 

Headquarter 
Avision Inc. 
No. 20, Creation Road I, Science-Based Industrial Park,  
Hsinchu 300, Taiwan, ROC 
TEL: +886 (3) 578-2388 
FAX: +886 (3) 577-7017 
E-MAIL:  service@avision.com.tw 
Web Site: http://www.avision.com.tw 
 
US and Canada Area  
Avision Labs, Inc. 
6815 Mowry Ave., Newark CA 94560, USA 
TEL: +1 (510) 739-2369 
FAX: +1 (510) 739-6060 
E-MAIL:  support@avision-labs.com 
Web Site:  http://www.avision.com 
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China Area  
Hongcai Technology Limited 
7A,No.1010, Kaixuan Road, Shanghai 200052 P.R.C.  
TEL :+86-21-62816680 
FAX :+86-21-62818856 
E-MAIL : sales@avision.net.cn 
Web Site: http://www.avision.com.cn 

 
Europe Area  
Avision Europe GmbH  
Bischofstr. 101 D-47809 Krefeld Germany  
TEL: +49-2151-56981-40 
FAX: +49-2151-56981-42 
E-MAIL:  info@avision-europe.com 
Web Site:  http://www.avision.de 

 

http://www.avision.com.cn/
http://www.avision.de/
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10. Specifications 
 
 
 
 
All specifications are subject to change without notice. 
 

Model Number DF-1015S (Duplex Scanner) 

DF-1004S (Simplex Scanner) 

Scanner Type Flatbed & ADF 

Scanning Mode Color/Grey/Black & White 

Optical Resolution  600  dpi 

Technology Contact Image Sensor 

Light Source LED 

ADF Max. Scan Size 8.5” x 14” (Legal) 

ADF Min. Scan Size 3.5” x 3.5” 

ADF Capacity 50 pages (20 lbs) 

ADF Paper Weight 16~28 lbs (60~105 g/m2) 

Interface High Speed USB 2.0 

Power Requirements 24Vdc, 2A  

Power Consumption < 30 watts  

Humidity 10~85%RH 

Operation Temperature 10~35°C 

Dimension 453*324*237 mm(W*D*H) 

Weight  4.3Kg 
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Index 
 

 

Ａ 
Additional Length Detection, 4-

39 
ADF roller, 8-6 
Auto Color Detection 

sensitivity, 4-7 

Ｂ 
B&W, 4-6 
Background Level, 4-27 
Background Setting, 4-53 
Barcode, 4-55 
Binarization 

Dynamic Threshold, Fixed 
Processing, 4-8 

Blank Page Removal, 4-49 
Brightness, 4-14 
Button Panel, 6-2 
Button Properties window, 6-2 

Ｃ 
Cache 

None, Page Number, Memory 
Size, 4-55 

Color, 4-6 
Color Dropout 

Remove Red, Remove Green, 
Remove Blue, Custom, 4-
25 

Color Matching, 4-18 

Contrast, 4-14 
Cropping 

Automatic, Fix to Transport, 
EOP Detection, 4-30 

Custom Font 
Normal, Fixed Width, 4-58 

Ｄ 
default settings, 4-3 
Deskew, 4-35 
Despeckle, 4-51 

Noise Number, Noise Radius, 
4-51 

Document Type 
Normal, Photo, Document, 4-

12 
Dynamic Threshold 

sensitivity, 4-8 

Ｅ 
Edge Fill, 4-49 
Energy Saving, 4-54 

Ｆ 
Filter Threshold, 4-27 
Fixed Width, 4-58 
Flip Side Rotation, 4-47 
Font Attributes 

Normal, Underline, Double, 
Bold, 4-58 



 

Ｇ 
G4, 4-23 
Gray, 4-6, 4-12 

Ｉ 
Intelligent Mode (Skip 

Multi-feeds) 
Disable, By 

Length(Paper/Object), By 
Position, By 
Length(Paper/Object)+Posi
tion, 4-39 

Invert, 4-16 

Ｊ 
JPEG, 4-23 

Ｍ 
Mirror, 4-50 
Multi-Feed Detection, 4-38 

Ｏ 
OverScan, 4-36 

Ｐ 
Print All, 4-58 
Print Position, 4-60 

Ｒ 
Reset Pad Count, 4-62 
Reset Roller Count, 4-62 
Resolution, 4-15 
Rotate Image, 4-48 

Ｓ 
Scan Area, 4-35 
String Orientation 

Normal, Rotated, Vertical, 
Vertical Inversion, 90 deg 
CW, 90 deg CCW, 4-59 

Ｔ 
Transport Timeout, 4-36 

Ｕ 
Ultrasonic Detection, 4-43 
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